Copy II Mac
CopyIIMac 7.0 has an INIT, CPSSaveDelete. Placed in your System Folder, it allows you
to reconstruct any trashed file, provided you did not write over it with new information.
Read your manual, owners, to find out how to use it.
Pirates -- you are out of luck. Go buy it.
Desk Accessories
Do not "split" a font between the System and a Suitcase folder. If you, for instance, place
Helvetica 12 in the System and Helvetica 9, 10, 14, 18, and 24 in a Suitcase folder, your Mac will
only find one of the Helvetica entries. It will ignore the presence of screen fonts in the other
sizes, and give you a rough view on the screen, as with any non-installed size.
It will print out OK, though.
Excel
To make an exact copy of a formula in an Excel spreadsheet, do another cell without
using absolute references, erase the = sign at the beginning of the source cell, then Copy and
Paste to the new cell. Now add the = sign in the new cell and replace it in the source cell.
Finder
Close all windows and leave a blank dummy document out on the desktop for each
application you use often. Now your Mac will start up faster, when it doesn't have to play with a
lot of applications.
For applications with no documents, create a one character text document. Now use
DiskTop, FEdit, etc. to change the Creator to the 4 character code of the application. Type
anything or nothing in the Type box -- except APPL. This document will now open your
"documentless" application.
An easy To Do List can be made by populating a folder named To Do List with empty
folders. Each folder's title is a To Do item. Takes almost NO memory, either. Leave it on the
desktop if you want it to be handy.
Clone it to other disks with a simple Finder-to-Finder copy, so you have it everywhere
you need it.
FKEY Manager

Some problems using FKEY Manager with System 4.1. Also, it is reported not to work on
a Mac II. A fix is on the way.
FullPaint
Does your mouse track slowly in FullPaint? Let up on the CapsLock key, sucker!
General
World's Best Tip 1984, 85, 86, 87 and 88.
Save often and back up anything you care about.
That's it folks. Wisdom in a nutshell.
To write on light colored disks, try Staedter Lumicolor pens with a fine point. Remove
with rubbing alcohol on a cotton ball. For dark colored disks, try Sanford's Discribe Markers in
silver. This is rather permanent. Don't try acetone, because it might reach the media inside, or
destroy plastic in the disk itself.
To use your floppy's system when you are up and running on a hard disk, hold down the
Option key while opening the application on the floppy.
With System 4.1, don't place an FKEY in the 0 slot. 4.1 does not like it, and may trash
your System, including some data.
Is your Mac approaching its second birthday? Treat it to a new battery. Eveready 523 or
equivalent. Don't pay more than $4.50, and $3 is more like it. Substitutes will not work. Read
my lips!
To move to the bottom of a long list of files in a dialog box, press the tilde (`) key. This is
the same idea as pressing letters of the alphabet to scroll quickly to the first item starting with
that letter.
To disable call waiting during a download, dial 1170 immediately followed by the number
you are dialing. Call waiting will be disabled for the duration of the call. When you hang up, you
are back to normal.
If your Mac II fan is noisy, there is some relief if you move any card in the #1 slot to the
#6 slot, where it doesn't disturb the air flow of the fan. Power off and cool the Mac down first.
Be sure you ground yourself when you get inside the Mac.

Yes, Virginia, you can leave your hard disk on all of the time, but it is a mechanical device
and the bearings will wear out in time. The first indication will be a high pitched whine -bearings screaming. One good plan is to turn the hard disk off anytime you will be leaving it
alone for several hours.
This subject is now terminated until someone comes up with something new about this
question.
You get a disk full message. You have no blank disks left. What to do? Let's suppose you
are working in MacPaint (a copy of MacPaint, of course). Go to the File menu and select Save
As… Give your artwork the name MacPaint. Save it. You will be asked if you want to replace
MacPaint with this new creation. Say yes.
You have now preserved your artwork. Quit and rearrange disks, make another copy of
MacPaint and go back to work. If MacPaint won't let you Save As… because it is "busy," select
any other application or document you have another copy of, and name it that -- it will replace
whatever you named it.
Graphics
For a quick pica ruler, take a screen dump of a Pagemaker page at 100% with the ruler in
view. Doctor it up in MacPaint or your favorite graphics program. Put it in the Scrapbook and
import it when you need it.
For journal-quality graphs, make them in CricketGraph and paste them into MacDraw.
Diddle with them, then Laserprint the result.
To make your screen dumps open up in FullPaint, make a copy of your System. Open it
with ResEdit. Open the System Folder, Open the System, scroll to FKEY. Highlight and Open
FKEY. Find FKEY ID = 3, highlight it and double click it. Click in the scroll bar about four
times, until you see PNTG on a line with MPNT on the next line at the far right of the screen.
Place your cursor after the T in MPNT. Carefully backspace EXACTLY four times. Now
type (carefully) PANT. Close all windows, saying "Yes" when asked if you want to save the
changes. Quit. Your screen dumps now open in FullPaint.
For other graphic programs, instead of PANT, type SPNT for SuperPaint, MMCB for
Graphic Works, or DAD(space) (that's DAD with a space after the second D) for Canvas.
This is not difficult, nor is it tricky. Just follow the steps exactly and use a copy of your
System to make you really FEARLESS.
Howdy Scrapbook! You have resized a graphic in some application. Paste it into the

Scrapbook and it reverts to its original size. I discovered this "feature" when it was not what I
wanted to happen.
HyperCard
Option/Tab tears off the Tools menu.
Option/Return lets you continue a line of script in HyperCard, using two or more lines as
a single line of script. When you invoke this you will see a ¬ mark appear at the end of the line.
Don't insert the ¬ yourself. Use Option/Return.
Don't place this return in the middle of a quoted string, and if you split a comment line,
begin EACH new line with a double hyphen.
When searching for a text string, the more information you type in, the faster HyperCard
can find it for you.
There is shorthand for many HyperCard script terms. Visual is OK instead of visual
effect, btn is button and bkgnd is background.
Command/drag make a new button in button tool. Option/drag copies the dragged
button.
Object names must be in quotes if they consist of more than one word. I suggest that you
put them in quotes even if they consist of single words. It makes them stand out in the script
when you are studying the script. And they don't hurt a thing.
To print just part of a script, highlight what you want and give the print command.
Command/s shrinks a marquee to barely fit around the object.
Beginners! Don't start right out in HyperCard. Learn the basic Mac functions, such as
Clipboard, Scrapbook, Font/DA Mover, Copy, Cut and Paste and so on first.
Wouldn't it be nice to have a bunch of your favorite button scripts available instantly?
Then use Acta. Copy from the Script, Open Acta and paste them in under a suitable keyword.
Thanks, FatBits, from Conejo Valley, Calif.
Those script lines preceded by a double hyphen are comments, and are not "seen" by
HyperCard. Use them plentifully for your own benefit, not to mention third parties who acquire

your stacks.
What version of HyperCard are you using? Type the version into the message box. Typing
the name produces the name of your version, and typing the diskspace shows how much room is
left on your disk.
If nothing works to let you see the menu bar in a stack, open the message box and type in
show menu bar and press Return.
To see the Protect Stack menu item in a locked stack, hold down the Command key while
you pull down the File menu.
In multi-user mode (TOPS?) HyperCard locks you out of any stack currently open on
another user's screen. Future HyperCard versions will lower the lockout to the card level.
Don't name your cards "First Card," "Second Card" and so forth. If you move one of
them, or insert a card in front of or between them, they will no longer be first or second card.
To convert SoundCap and other sound files to snd files which HyperCard can use,
SoundConvert 1.0 looks like the best bet.
If your Mac keeps asking for HyperCard disks you no longer need to see, use the old
familiar Command/period to make your Mac forget those disks. This works unless your Mac
really needs to see those other disks.
To print out a discontinuous selection of cards (Yes, you can too do this!!), get
HyperBook Maker from Ideaform in Fairfield, Iowa. Not only can you print selected cards out of
order, but it prints them in a little book, with the signatures all figured out so that it folds and
staples just right.
Know what I am talking about? If you take a 20 page booklet apart, you will find pages 1
and 20 side by side, 19 and 2 will be on the other side, and so forth.
Look for a review soon. $59.95. But don't wait for the review -- it makes a neat book.
One hint, though! If the stack is not linear -- that is if the desired order for a book is not
cards 1-? in order, be sure you use HyperBook Maker's capability to let you select each page and
position it in your book. Example: Inigo Gets Out is not a linear stack, and a straight printout
will not be in an order which is pleasing to you.
Customize it.
Here's a cute script to let you temporarily unlock a field so you can change the text, then

lock the text again when you are finished. Let's call the field we want to act on "My Field."
on mouseUp
set lockText of bkgnd field¬
"My Field" to not¬
(lockText of bkgnd field "My Field")
set hilite of the target to not¬
(hilite of the target)
end mouseUp
Use a check box style of button, which you can name appropriately, "Lock/Unlock
Text." (Thanks, NibbleMac -- which has one of the best HyperCard script tutorials I have seen
anywhere. It is stated in "the rest of us" terminology, with suitable alliterative examples.)
Always compact your stack before you give it to someone. And to modem it, after
compacting, use Stuffit to get a bit more compression before sending over the phone.
Happy idea, add this line to be executed every time you leave any stack:
do menu CompactStack
Command/period (.) stops a script from operating.
Hold the Shift key down to make your rounded-rectangle buttons in HyperCard the
"official" Macintosh height for buttons. You know, like you see in Mac dialog boxes.
Shift only does this on rounded rectangle buttons. It works to constrain movement to
vertical or horizontal on other button styles.
When you are in the script dialog box, you are locked out of the menu. But you can use
Command key combination with X,C,V,F,G,H,P and A, among others. This means you can Cut,
Copy and Paste while in the script dialog box. The arrow keys also continue to work.
If you have QuickKeys you can probably do a bunch of other things, too.
High resolution printout of HyperCard occurs only in fields. In fact, only in fields which
are obscured in no way by any other field or graphic rectangle. You get bitmap if any part of the
field is obscured.
Exception, a transparent button will not keep you from getting high resolution.
To temporarily store and manipulate values, use a container. You can put values into
containers you can name 'it,' 'selection,' or anything you wish, like 'pizza,' 'oboe' or 'DonnaRice.'
To change the order of cards in a stack, you can Cut and Paste. You figure it out. It's easy.

Imagewriter
To do stencils on the Imagewriter II (one more time), adjust the print head for four
copies and use AB Dick 2060 stencils or the equivalent.
The Imagewriter II will print in Hex if you depress the Select button when turning the
IWII on. Don't lean on it if you don't want to see Hex printed out.
LaserWriter
Use the precision bit map option and even LaserWriter fonts will look better. To test this,
type a 12 point capital letter C in Times Bold and print it out with and without the precision bit
map option checked.
Now use a loupe (the kind the printer uses to tell you how much better his output is than
your LaserWriter 300 dpi) magnifying glass and examine the printout.
Thanks, AMUG News from Alaska.
To squeeze "just a little bit more" on a page, select A4 paper size in the Page Setup box.
Thanks, Paul Vilandre, Menlo Park, CA.
When making overhead transparencies on the LaserWriter, hand feed the foils
(transparencies), but do not specify manual feed. This way you get the foils automatically
slipsheeted with plain paper. Thanks, Paul Vilandre, Menlo Park, CA.
If you need material from two applications on one LaserWriter printout, print out the
first application, leaving room for the second application material. Now pump up the second
application and hand-feed the first printout through. I usually do 2-3 copies so I can goof up
safely. Thanks Paul Vilandre, Menlo Park, CA.
To "digitize" a photo when you lack a scanner, leave space for the photo and print
everything else out. Now combine the photo and the printout using a good quality office copier.
I said good quality, and if screens are available for this copies to enhance photos by
imparting a dot pattern, try it, too.
If you use more than one mode for your LaserWriter, buy a 40¢ knob #274-403 from
Radio Shack. It fits the mode switch with a clamp and makes it easier to change.
Another way to keep the LaserWriter from printing a test sheet when you turn it on: Pull

the paper tray out about an inch until the green light is on steady. Then shove it back in.
The other ways? Widgets from CE Software and writing in PostScript code to effect the
change.
Widgets is by far the simplest.
To manually feed legal size paper with a normal paper tray installed, use the Options
dialog box in the Page Setup for LaserWriter drivers 4.0 and newer and check the bottom box,
Larger Print Area.
Works like a charm.
MacDraw
To change the default font and object attributes, after making your font, size, fill, and line
choices, click on the line/pattern box in the lower left of the screen. Newly created objects and
text will use the new defaults until you change them.
MultiFinder
To print out your job at 2:30 am, use SetPrintTime to specify that hour. Like, if you get
fired, spool a nasty note to the boss and set it to print out 1,000 times some night in the middle
of next week.
You don't have to reboot to start MultiFinder. Command/Option/double click on its icon.
Use the grow box! That's what it's there for. Shrink every application you have open and
assign it to a position on the screen. To use it, click the grow box and it fills the screen. To close
it, click the grow box again and it reverts to the size you assigned to it.
Hold down the Option key while selecting a DA and it will be opened within the active
application's memory space.
If you have a version of PopKeys prior to 2.5 on your disk, get rid of it right now, before
you boot MultiFinder. 2.5 won't give you a bomb, though.
Pagemaker
You have just changed type style for the next line. You type a word. You decide it is the
wrong word. You delete it and type in a new word. Your font and style revert to the font and
style of the previous line or to the default font. Damn! Another trip to the menu bar.

If you want to replace the word and retain your new formatting, highlight back to, but not
including, the first letter on the line. Now start your new word. Next, go back and delete the first
letter on the line. You have preserved the formatting without another trip to the "bar" -- menu,
that is.
Use SuperGlue to "print" your image (text and graphics). Now reimport the image to
Pagemaker and you can stretch, shrink or distort it to fir a specific area, or to indulge a
particular layout whim.
Pagemaker 3.0, if you haven't already gotten it, will
• flow text automatically throughout a page or document, with keyboard control
• provide style sheets -- user definable
• include 30 templates
• support spot color
• wrap text around graphics in several ways
• give you independent horizontal and vertical measuring preferences
• optional greeking
• precision alignment of side by side text
• new keyboard shortcuts
• extra pages for text overflow
But can I use AutoMac, Tempo or QuickKeys efficiently for font changes?
To keep an entire story from shifting around in Pagemaker 2.0 when you make a small
change on one page, Cut and immediately Paste the text block you want to work on. This block
is now an entity, connected to no other block. Change to your heart's content.
Smash Hit Racquetball
The word is that you cannot make a backup copy of Smash Hit Racquetball. In fact, if you
try with CopyIIMac, it trashes your blank disk so the Mac can't even initialize it.
Well, folks, if you ran into this, I hope you saved your disk. Pass a bulk cassette or reel-toreel tape eraser over the disk (not over your watch, dummy!) and your disk is ready for the Mac
to initialize again.
SpellsWell
SpellsWell 2.0a does not catch all the spelling mistakes. However, this is true of all
spelling programs. In SpellsWell, try oppoertunity, for instance.
In Word 3.01, try the non-word ths. Not this, but ths.
Garbage in, garbage out.

StuffIt
If you have a lot of disks full of MacStuff and want to save disk space, get StuffIt.
It compacts files from 5% to 60% depending on the contents. It is an absolutely safe
process which does not corrupt information. $15 shareware if you archive files with it. Free if
you only decompress files you receive.
Word
Word 3.01 only addresses a megabyte, so don't waste any more space on it in
MultiFinder.
The Word Companion, by Mynheir and Cobb, $19.95 is being touted as the best of the
Word third party books.
To select an entire table as a single paragraph for export to a page makeup program,
select the entire table less the paragraph marker for the final line. Go to the Change… menu
item under Search. Enter ^p in the Find box and ^n in the Change To… box. The result is a table
which is one paragraph. This makes it easier to export it without tabbing problems, and also
means you can box it in Word, since it is a single paragraph.
Don't forget the straight up-and-down vertical line just after the decimal tab in the ruler
of Word 3.01. That gives you nice vertical lines anywhere you want them on the page.
Second chapter: counting words in Word 3.01. Do a Save. Look in the lower left corner of
the screen for the character count. Divide it by 6.355 and you have the approximate number of
words.
Test the 6.355 number against some samples of your writing. It should be close, but you
can refine it for your personal use.
This formula makes sense since words most often average slightly more than five letters
each, and there is a space after about every word. This adds to six plus character/space positions
in the character count.
Unless you write funny, that is.
Thanks, MacWorld.
Would you like to use the LaserWriter driver 4.0 and newer Options dialog boxes with
Word 3.0? Hold down the Shift key while choosing Page SetUp and Print.

